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Preface

Preface
Welcome to the JD Edwards EnterpriseOne documentation.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at  http://
www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc .

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For
information, visit  http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info  or visit  http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=trs  if you are hearing impaired.

Related Information
For additional information about JD Edwards EnterpriseOne applications, features, content, and training, visit the JD
Edwards EnterpriseOne pages on the JD Edwards Resource Library located at:

http://learnjde.com

Conventions
The following text conventions are used in this document:

Convention Meaning

Bold
 

Boldface type indicates graphical user interface elements associated with an action or terms defined in
text or the glossary.
 

Italics
 

Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular
values.
 

Monospace
 

Monospace type indicates commands within a paragraph, URLs, code examples, text that appears on a
screen, or text that you enter.
 

> Oracle by Example
 

Indicates a link to an Oracle by Example (OBE). OBEs provide hands-on, step- by-step instructions,
including screen captures that guide you through a process using your own environment. Access to
OBEs requires a valid Oracle account.
 

i

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://learnjde.com
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1  Working with the Composite Application
Framework

Understanding the Composite Application Framework  
Oracle's Composite Application Framework for JD Edwards EnterpriseOne is a user interface framework that enables
users to work with content from multiple sources within a single browser window. The Composite Application
Framework enables authorized users to embed external website page content, multiple EnterpriseOne forms, and
Oracle Business Intelligence Enterprise Edition (OBIEE) objects directly onto a defined EnterpriseOne application form.
The same content can be reused and shared by multiple users in multiple transactions on the same EnterpriseOne
application form. The Composite Application Framework is informally referred to as CafeOne.

A defined EnterpriseOne application form is a form that your JD Edwards EnterpriseOne administrator has enabled for
you to access on the Composite Application Framework. The enabled form is fully functional. Web page content and
OBIEE object content can be viewed and used the same way you use the web page or OBIEE object when you enter a
URL on an Internet browser.

You can update an embedded EnterpriseOne form. When you save the change on an embedded EnterpriseOne
form, the JD Edwards EnterpriseOne database is updated. You can refresh the enabled form to show the update that
was made on the embedded form by clicking Find, and then all other embedded forms that show the updated field
automatically refresh and display the change.

When you open an authorized EnterpriseOne form, the framework always shows the EnterpriseOne form. Typically
one or more layouts are available for the form. A layout consists of one or more frames of content. Content can be
pages from a website and OBIEE reports. Layouts display content vertically and horizontally in the framework, and the
EnterpriseOne form and content are viewed in a single browser window. You can view a frame of content in a separate
browser window. You can resize, minimize, and maximize content frames.  

Features  
The JD Edwards EnterpriseOne Composite Application Framework provides the following features:  

• EnterpriseOne administrators enable the Composite Application Framework for a select group of users on
select JD Edwards EnterpriseOne application versions and forms.

• EnterpriseOne authorized users associate EnterpriseOne business data with external website pages and OBIEE
objects, and then share the content on a layout so that other authorized EnterpriseOne users can view the
EnterpriseOne application form and content on the Composite Application Framework within a single browser
window.

• EnterpriseOne authorized users can associate different website pages and OBIEE objects for different
EnterpriseOne application forms and business records.

• Website page content and OBIEE object content are defined by a URL and appear on the Composite Application
Framework as a frame of content with the option to display the content in a separate browser window.

• The Composite Application Framework displays content from multiple sources, with the content information
available in separate, adjustable frames that are positioned both horizontally and vertically on the framework.

• EnterpriseOne authorized users can minimize content frames to provide more space on the framework for
remaining frames.

1
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• EnterpriseOne authorized users can easily maximize minimized frames, which returns the content frame to its
original position on the framework.

• EnterpriseOne authorized users can define conditions for when to display specific content on the
EnterpriseOne application form.

• EnterpriseOne authorized users can map data values on the EnterpriseOne form to URL parameters (web
pages, and OBIEE objects) so that the content automatically changes when an authorized user or process
changes the value on the EnterpriseOne form.

• All functionality is accomplished using the web client without the involvement of development.

• An authorized user can design a layout that contains one or more embedded EnterpriseOne forms as well as
web page and OBIEE content that provide related information for working with the enabled EnterpriseOne
form. These composite layouts can provide beginning-to-end information for a functional area (such as
equipment, customers, suppliers, inventory, collections, employees) within a single browser window.

• Users can update fields on the embedded EnterpriseOne form and save the change. The change updates the
JD Edwards EnterpriseOne database. When the enabled form is refreshed by clicking Find, the update appears
on other embedded forms that show the field.

Note:  This does not apply to embedded EnterpriseOne forms that are external forms. (Release 9.2.1)

• The embedded EnterpriseOne form feature improves productivity by mimicking what a user currently can
do manually in EnterpriseOne by building power forms that contain multiple subforms that show related
information pertaining to a master record.

Accessing the Composite Application Framework  
Your EnterpriseOne administrator authorizes users and EnterpriseOne forms for collaboration on the Composite
Application Framework. Your EnterpriseOne administrator also grants permission to view, create, and publish content.
Your administrator assigns you as one of the following user types:  

• View the Composite Application Framework 

Enables you to run EnterpriseOne applications on the Composite Application Framework and view content on
shared layouts that are associated with the EnterpriseOne application form.

• Create Content and Layouts 

Enables you to create content and place the content on a personal layout for your use only.

• Create and Publish Content and Layouts

Enables you to create content and place the content on a layout that can be published so that other authorized
users have access to the content on the shared layout.

• Modify Layouts

Enables you to modify shared layouts created by other authorized users.

2
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2  Using the Composite Application Framework

Using the Composite Application Framework  

Note:  If you use a mobile device, some content may not display correctly or may cause the Composite Application
Framework to not work properly. A known issue for the iPad is that OBIEE content does not directly appear on the
Composite Application Framework. Instead of the OBIEE report, the OBIEE login window appears in the OBIEE content
frame. To view the OBIEE report, click the popup icon in the OBIEE report content frame. The popup browser window
displays the OBIEE report. You may need to refresh the browser window.   

Viewing the Composite Application Framework  
All authorized users have Viewer access to the Composite Application Framework. When you open an enabled
EnterpriseOne form, the Composite Application Framework shows the enabled form along with one or more layouts that
show frames of content that contain information from other sources. A user who is authorized to create and publish
content organizes content frames on a layout and publishes the layout so tat authorized users can view and use the
content on the layout. Your EnterpriseOne administrator controls the content that is available for you. 

The following conditions must exist for you to use the Composite Application Framework:

• You are enabled to view the layout of the Composite Application Framework.

• You are granted access to the content in the layout.

If you do not have access to a frame of content, the content frame does not appear on the layout.

• Your EnterpriseOne preferences shows the Show Layout option selected.

Note:  If you do not see the Composite Application Framework and your EnterpriseOne administrator has enabled
you as a viewer for an EnterpriseOne application form, verify that the Show Layout option is selected in your
EnterpriseOne preferences. To do this, on EnterpriseOne, click the down arrow next to your user name, click
Preferences under the Personalization category, and then select the Show Layouts option. If this option is selected and
you do not see the framework, contact your EnterpriseOne administrator.  

You can change your view of the framework by: 

• Selecting a different layout, if available.

• Minimizing and maximizing content frames.

• Resizing content frames.

• Viewing content in a separate browser window.

3
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Understanding Layouts and Content  
A layout always shows the enabled EnterpriseOne form along with content frames that contain information relevant to
the enabled form. A content frame can contain the following types of content: 

• A web page URL.

• An embedded EnterpriseOne form.

• An OBIEE object.

• Attachments. (Tools Release 9.2.8.2)

When you exit the enabled application form, the next time you open that form, the Composite Application Framework
displays the layout and content as you last used them.

Understanding Layouts  
Layouts are created by authorized users and shared with you. You cannot remove content frames or change the
position of content frames on the layout. If more than one layout is available for an EnterpriseOne form, you can select
a different layout from the Layout drop-down list. The Layout drop-down list shows two categories of layouts. Layouts
listed under the My Layouts category are personal layouts created by an authorized layout creator and copied to your
view of the Composite Application Framework. Layouts listed under the Shared Layouts category are shared with
members of a role or with all EnterpriseOne users. 

Understanding Content Frames  
A layout always shows the enabled EnterpriseOne form and content. The content appears in content frames and can
be from a web page, an OBIEE object, or an embedded EnterpriseOne form. A layout can contain any one or more
of the content types (web page, OBIEE object, embedded EnterpriseOne form). The content frame title bar typically
shows a title for the content and shows minimize and popup icons. You can resize a content frame to show more or less
content. When you minimize a content frame, more space is available on the framework for the EnterpriseOne form and
the remaining content frames. You can easily maximize a minimized content frame. Content frames are vertically and
horizontally grouped on a layout that appears on the framework.  

When a content frame title bar is highlighted in gold, the content frame is dynamically linked to the EnterpriseOne
form. A dynamic link occurs when your EnterpriseOne content manager links a field from the content frame to a field
or grid row column on the embedded form. When you change the value of the header field or select a different grid
row on the enabled EnterpriseOne form, the information in the linked content frame automatically updates to show the
appropriate information for the changed value or grid row. Your content manager should inform you of the fields that
are dynamically linked.

Your content manager can create content that shows on a layout only when specific conditions are met. For example, a
certain content frame might be designed to appear on the framework only when the value in the Search Type field on
the enabled form is equal to E. If you change the search type field value from E to any other value, the content frame
does not show on the framework. These are called conditional settings. Your content manager should inform you of
content frames that are designed to appear only when certain conditions are met.

Missing Content  
If you expect to see a frame of content for the enabled EnterpriseOne form, but it does not show on the Composite
Application Framework, open other available layouts and verify that the content is not available for the EnterpriseOne
form. Reasons that content might not be available are:    

• The status of the layout that contains the content is Pending and is waiting for approval before it publishes.
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• The layout that contains the content was not shared with you.

• The content is designed to appear only when the conditional values on the open EnterpriseOne form match the
values that the content creator defined.

• If you do not have access to the OBIEE server, content frames that contain OBIEE object information show a
message indicting the content is not available to you.

Viewing and Using Content  
A layout always shows the enabled EnterpriseOne form. The layout can show any combination of content frames that
provide web page information, an OBIEE object, and other EnterpriseOne application forms. If the content creator links
the content frame to the enabled form, when you can change a value on the enabled form the linked content frames
update the information in them to show relevant information for the linked field. these are dynamic links. 

The following illustration shows an example layout, which includes the enabled EnterpriseOne form, web page content,
embedded EnterpriseOne form content, and OBIEE object content:

The illustration shows an example layout on the Composite Application Framework. The layout shows: 

1. The Work with Addresses (W01012B) EnterpriseOne form.
2. The name of the current layout for the form is Document Layout. If other layouts are available for this form, you

can select a different layout from the Layout drop-down list.

5
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3. OBIEE report content that is dynamically linked to the Work with Addresses form. The content title bar and the
EnterpriseOne form grid row are highlighted.

The highlighted title bar indicates that the information in the content frame changes when you change the
value of the EnterpriseOne form-level field or grid column (in this example, the Alpha Name column).

4. OBIEE report content that is static; changing the value on the EnterpriseOne form does not affect the content.
5. Web page content that is static; changing the value on the EnterpriseOne form does not affect the content.

The content frames (items 3, 4, and 5) show a Popup icon and Close icon in the title bar. Clicking the Popup icon
opens that content in a separate browser window. Clicking the Close icon minimizes that content.

6. Minimized web page content. Clicking the tab maximizes the content so that it appears on the layout.

Viewing and Using Web Page and OBIEE Content on a Layout  

Content that contains web page information and OBIEE object information have a URL that is embedded on the layout.
When you open the enabled EnterpriseOne form in the Composite Application Framework, you view and use the URL
web page or OBIEE object the same way you use the web page or OBIEE object when you access it through and Internet
browser using a URL.

Viewing and Using Embedded EnterpriseOne Form Content on a Layout  
Embedded EnterpriseOne form content behaves slightly differently depending on whether the embedded
EnterpriseOne form is a standard EnterpriseOne form or an external form.

Standard Embedded EnterpriseOne Forms

You can update information on an embedded EnterpriseOne form. Changes that you make and save on an embedded
EnterpriseOne form updates the Oracle JD Edwards EnterpriseOne database.

In addition to the content frame title bar, which contains the content name and popup and minimize icons, content
frames that contain embedded EnterpriseOne forms also show the EnterpriseOne form title bar. Functionality on
embedded EnterpriseOne forms is restricted. All of the embedded EnterpriseOne forms provide Save and Refresh
capabilities. The OK icon enables you to submit and save changes. The Refresh icon cancels unsaved changes. Some
of the embedded EnterpriseOne forms provide additional capability, such as Find and Delete. You cannot access
other forms from an embedded EnterpriseOne form. Row and Form exits and hyperlinks do not work on embedded
EnterpriseOne forms.

External Forms as Embedded EnterpriseOne Forms (Release 9.2.1)

An external form is the window through which users interact with an external application like an Application
Development Framework (ADF) application, or a JET page or Composed EnterpriseOne Page.

The principle value of an external form is that it provides a direct link to an external application and allows it to be
displayed within an EnterpriseOne web client. This means it can be a task, within a Composed EnterpriseOne Page, on
a menu, linked to from an EnterpriseOne page, accessed through Fastpath, or used as content within the Composite
Application Framework.

The functionality available for the embedded EnterpriseOne form depends on the functionality built into the ADF
application or JET page.

Note:  You cannot embed an external form with a Composed EnterpriseOne Page as its external application type in a
Composite Application Framework layout.
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For more information on creating external forms, see "Understanding External Forms" in the  JD Edwards EnterpriseOne
Tools Form Design Aid Guide .

Viewing Multiple Content Frames on a Layout  
A layout always shows the enabled EnterpriseOne form and can be designed to show any combination of content
frames that provide web page information, an OBIEE object, or another EnterpriseOne form. When you change a value
or grid row on the enabled form, the content in any embedded form that is linked to the enabled form changes to show
information that is relevant to the changed value or selected row on the enabled form. A content frame can be designed
to appear on the layout only when certain conditions are met.

The following illustration shows an example layout, which includes the enabled EnterpriseOne form, web page content,
and embedded EnterpriseOne form content:

The illustration shows:

1. The name of the active layout for the form. This layout is named Display Multiple Content_SO. If other layouts
are available for this form, you can select a different layout from the Layout drop-down list.

2. The enabled EnterpriseOne form, Work With Addresses (W01012B). The Work with Addresses title bar stretches
across the width of the layout. The enabled form is fully functional and works the same way on the framework
as it does outside the framework in EnterpriseOne. If you update a field on the enabled form, when you click
Find, the update is applied to any other content frames that are linked to the enabled form.

3. An embedded EnterpriseOne form, Address Book Revision (W01012A) from the Address Book application
(P01012). The title bar of the content frame is highlighted in gold, indicating that this form is linked to the
enabled form, Work With Addresses.

7
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4. An embedded EnterpriseOne form, Phone Numbers (W0115A) from the Phone Numbers application (P0115).
The title bar of the content frame is highlighted in gold, indicating that this form is linked to the enabled form,
Work With Addresses.

5. A web page. In this example the content that is embedded in the framework is the Oracle  JD Edwards
EnterpriseOne Applications Address Book Implementation Guide  . Your content manager designed this content
so that it always appears for the enabled form, Work With Addresses. Because the web page URL for this
content frame is specifically for the Address Book guide, you can select different chapters from the Address
Book Guide, but you cannot select another guide from the library.

6. An embedded EnterpriseOne form, Who's Who (W0111A) from the Who's Who application (P0111). The title bar
of the content frame is highlighted in gold, indicating that this form is linked to the enabled form, Work With
Addresses.

7. An embedded EnterpriseOne form, Sales Order Header (W4210G) from the Sales Order application (P4210). The
title bar of the content frame is not highlighted, indicating that this EnterpriseOne form is not mapped to the
grid row of the enabled form, Work With Addresses. Because the embedded form is not linked to the enabled
form, the content in this frame does not change when you change a value in the enabled EnterpriseOne form.
The content frame is designed to always appears on the layout.

You can use this form to add a new sales order record. When you add a new record and click Save, the
EnterpriseOne database is updated. When you click Find on the enabled form, Work with Addresses, all of the
other content frames that are mapped to the Work with Addresses form are updated to reflect the newly added
record.

8. An embedded EnterpriseOne form Customer Service Inquiry (W4210E) from the Sales Order application
(P4210). The title bar of the content frame is highlighted in gold, indicating that this form is linked to the
enabled form, Work With Addresses.

9. A web page. In this example the content that is embedded in the framework is the Oracle JD Edwards
EnterpriseOne Application Supply Chain Management (SCM) and Manufacturing (MFG) documentation
library. This content is designed to appear on the layout only when the enabled EnterpriseOne form shows C
(Customers) as the value in the Search Type field. Your content manager should inform you of any conditional
criteria for displaying a frame of content.

The following illustration shows the same layout as above, but with content frames minimized to provide a different
view. The annotated numbers on the illustration are the same as on the previous illustration:

8
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The illustration shows:

1. The name of the active layout for the form, which is the same layout shown in the previous illustration.
2. The enabled EnterpriseOne form, Work With Addresses (W01012B). Instead of a value of C in the Search Type

field, that value is changed to E. After changing the value, pressing Tab, and clicking Find, all of the embedded
content that uses the Search Type field are updated to show content for Employees (E) instead of Customers
(C).

3. The embedded EnterpriseOne form, Address Book Revision (W01012A). This content now reflects information
that is appropriate for the row that is selected in the Enabled form, Work With Addresses.

4. The embedded EnterpriseOne form, Phone Numbers (W0115A). This content now reflects information that is
appropriate for the row that is selected in the Enabled form, Work With Addresses.

5. The web page for the   JD Edwards EnterpriseOne Applications Address Book Implementation Guide  . This
content frame is resized to show more information. If you need to see still more information, you can click the
popup icon to open the content in a separate browser window. Because the web page URL for this content
frame is specifically for the Address Book Guide, you cannot select another guide from the library.

6. The embedded EnterpriseOne form, Who's Who (W0111A) expands across the entire lower half of the layout
because all of the other content frames on the bottom portion of the layout are minimized. You cannot
reposition content frames on the layout.

7. The embedded EnterpriseOne form, Sales Order Header (W4210G) is minimized and appears on the right side
of the layout as a tab. When you click the tab, the content appears on the layout in the same location shown in
the previous illustration.

8. The embedded EnterpriseOne form Customer Service Inquiry - Updates Allowed (W4210E) is minimized and
appears as a tab on the right side of the layout. When you click the tab, the content appears on the layout in the
same location shown in the previous illustration.

9. The web page content for the EnterpriseOne SCM & MFG library no longer shows as either content or a tab.
This is because the Search Type field on the enabled form now has a value of E.

9
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Adding a New Record to the EnterpriseOne Database  
You can create a new record on an Embedded EnterpriseOne form that is not linked to the enabled EnterpriseOne form.
The following illustration shows the layout, Display Multiple Content_SO, with changes to the content frames that you
can make to change your view of the layout so that you view only the content frames that are needed to accomplish
your task.

This layout shows the enabled EnterpriseOne form, which always appears on the layout. In the above illustration, the
enabled form expands across the top half of the layout because the other content frames are minimized. The layout
shows content that contains the Sales Order Entry form (W4210G) and content that shows Chapter 7 of the   JD Edwards
EnterpriseOne Applications Sales Order Management Implementation Guide  . When you minimize content, the system
changes the size of remaining content to fill in the space that the minimized content originally filled.

All of the other content frames are minimized. Clicking the minimized content tab opens the content on the layout in its
original position. You cannot reposition content on the layout.

Modifying an Existing Record  
You can add, update, and delete existing information on embedded EnterpriseOne forms. When you update a value
on a linked embedded form and save the change, you update the EnterpriseOne database. When you click Find on the
enabled form, the layout refreshes showing the update on all content frames that use the value and are linked to the
enabled form. If a content frame is minimized when the change is made, when you click on the minimized content tab,
the content appears on the layout with the change.

If you make a change on an embedded form and forget to save the change, the system provides an error message and
lets you either save or cancel the change.

10
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Note:  Updating the EnterpriseOne database and error messaging do not apply to embedded EnterpriseOne forms
that are external forms. (Release 9.2.1)

The following illustration shows the layout, Display Multiple Content_SO, with changes to the content frames that you
can make to change your view of the layout so that you view only the content frames that are needed to accomplish
your task.

For this example, the content frame named AB Revisions - Updates Allowed will be updated. The change will be to the
Alpha Name field.

To update an embedded EnterpriseOne form:

1. On the content titled AB Revisions - Updates Allowed, change the Alpha Name field from General Corporation
to General Corporation, Inc., and then press Tab.

Pressing Tab ensures that the system recognizes the change.
2. Click the Mailing tab and change the Mailing Name field if appropriate.
3. On the embedded form title bar, do one of the following:

a. Click Save.

Clicking Save updates the EnterpriseOne database with the change. The content frame that contains the
embedded form refreshes and shows the updated information.

b. Click Refresh.

Clicking Refresh before you save a change, cancels all unsaved changes that you made on the form. The
content frame that contains the embedded form refreshes and shows the original information.
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4. To see the saved change on the layout, click Find on the enabled form.

When you click Find, the layout shows the change on the enabled form. The system also refreshes the layout so
that all linked content frames show the change.

CAUTION:  When you click Find on the enabled form, the system refreshes the layout, moving the cursor to
the first record in the grid row. Be sure to reselect the record that you are working with.

If you make a change on an embedded form and do not save the change, when you click Find on the enabled form or
if you try to open a different layout, the system shows the content frame title bar in red font, and displays a warning
message indicating the updates will be canceled.

Note:  This warning message does not apply to embedded EnterpriseOne forms that are external forms. (Release
9.2.1)

The following graphic illustrates this warning message:

Clicking OK on the warning message cancels any unsaved changes that you made in that content frame.

Note:  If you selected a different record on the enabled form, that newly selected record shows in the content frame. If
you selected a different layout, the newly selected layout appears on the frame.

Clicking Cancel returns you to the content frame with the changes that you made so that you can save your updates.
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CAUTION:  When you click Cancel, the system refreshes the layout with the newly selected record highlighted on the
enabled form, and other embedded forms are refreshed to show the newly selected record. Only the embedded form
that you are working with shows the originally selected record with your changes.  To make sure that all content on
the layout is synchronized, reselect the desired record on the enabled form and click Find.

Viewing and Using Attachment Content on a Layout (Tools Release 9.2.8.2)  
When you open the enabled EnterpriseOne form in the Composite Application Framework, you can view and use the
attachment content type within the Composite Application Framework layout and directly work with the attachments in
the Media Object Viewer.

See "Creating A CafeOne Layout for the Media Object Viewer".

Minimizing and Maximizing Content Frames  
A layout might show more content than you want to view. You can minimize a content frame to provide more room for
the EnterpriseOne form and other content frames. When you minimize a content frame, it appears as a tab on the right-
hand side of the framework.     

To maximize a minimized content frame, click the tab. The content frame appears on the framework in the same
position it was before you minimized it.   

Resizing Content Frames  
   You can change the size of a content frame. When you resize a content frame, the framework automatically resizes
adjoining content to fit on the framework. To resize a content frame, place your cursor either horizontally or vertically
between two content frames. A thin blue line appears, and you change the size of the content frame by moving the blue
line.

Note: The feature is not available for the iPad.   

Viewing Content in a Separate Browser Window  
Each content frame title bar includes a popup icon. When you click the popup icon, the content appears in a separate
browser window. Close the browser window to return to the framework.  

Note:  If using an external form as your embedded EnterpriseOne form, the popup icon is not available. (Release 9.2.1)
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3  Working with Content and Layouts

Working with Content and Layouts  

Note: You may not be able to perform the tasks in this chapter on a mobile device.     

Note:    Click here to view a recording that shows how to access the framework edit mode, create embedded
form content that is dynamically linked to the enabled form and has conditional settings for displaying the

content, is placed on an existing shared layout, and is requested for publishing.

Understanding Content and Layouts  
Your EnterpriseOne administrator grants permission for you to create, publish, and modify content and layouts for an
enabled EnterpriseOne form. In addition to these permissions, your administrator must also enable content security to
authorize you and other enabled users to work with and view content types.

See "Managing Content Security for Composite Application Framework" in the   JD Edwards EnterpriseOne Tools Security
Administration Guide   .

Assuming content security is enabled and the appropriate permissions have been granted, the system supports creating
these types of content:

• Web Page URLs

• Embedded EnterpriseOne Forms

• Oracle Business Intelligence Enterprise Edition (OBIEE) Objects

• Attachment (Tools Release 9.2.8.2)

Note:  To create OBIEE content, the Oracle BI Enterprise Edition and the Oracle BI Applications adapter for
EnterpriseOne must be installed and setup for your environment, and you must have permission to access this
environment. See Configuring a Business Intelligence Connection

You use the Edit mode of the Composite Application Framework to create content and layouts. All content must be
saved on a layout.

Your administrator grants permission to create these two types of layouts:

• Personal layouts, which are available only to you.

• Shared layouts, which can be published and shared with other users.

The content on shared layouts is available for other authorized users to use on their layouts for the same enabled form.

Note:  The Composite Application Framework application is shipped with a limited number of content frames allowed
for a layout. You can request your system administrator use Server Manager to change the CafeOne Maximum
Contents per layout setting under the Web Objects Settings heading. Adding additional content frames might cause
performance degradation.
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Understanding Web Page Content  
Web page content is the information that you see when you access an Internet site using a URL address. Within the
Composite Application Framework, you use the web page content the same way as when you access the web page
typing a URL in a web browser address bar. You can map the web page content to the enabled EnterpriseOne form so
that when information on the enabled EnterpriseOne form changes, the web page content changes.   

Understanding Embedded EnterpriseOne Form Content  
The embedded EnterpriseOne forms feature enables you to design a composite application that provides beginning-
to-end information relevant to a functional area (such as equipment, customers, suppliers, inventory, collections,
employees) on a single browser window. The functional area is identified by an enabled EnterpriseOne application form
and relevant information that is available on one or more embedded EnterpriseOne forms and from other sources (such
as a web page or a business intelligence object). You can map the embedded EnterpriseOne form content to the enabled
EnterpriseOne form so that when information on the enabled EnterpriseOne form changes, the embedded form content
also changes.  

Understanding Oracle Business Intelligence Content  
Creating Oracle Business Intelligence Enterprise Edition (OBIEE) content frames provide users quick access to Oracle
Business Intelligence information. OBIEE content frames are available on the Composite Application Framework only
when OBIEE and the Oracle BI Applications Adapter for EnterpriseOne are installed and setup for your environment. To
create and view the OBIEE content, you and any user who needs this information must have access to the environment.

Understanding Attachment Content (Tools Release 9.2.8.2)  
Creating Attachment content frame provides you quick access to Attachment content type. You can embed the
attachment content type within the Composite Application Framework layout and directly work with the attachments in
the Media Object Viewer.

See "Creating A CafeOne Layout for the Media Object Viewer".

Understanding the Framework Edit Mode  
You must be in edit mode to create new content and layouts or to make changes to existing content and layouts. When
you click the Layout drop-down list, you see layouts that are available to you and is in one of these categories:

• Personal: Layouts that are viewable by you only.

• Pending Approval: Layouts that you created and requested the layout be published so that it can be shared with
other authorized users. Only you can see your layouts that are pending approval.

• Rework: Layouts that are rejected for publishing and have been returned to you for fixing. Only you can see
layouts that are in the Rework category.

• Reserved: Layouts that you have moved from Pending Approval so that you can change them before they are
published or your layouts that are rejected for publishing and are in the Rework category.

You can reserve an existing shared layout. When you reserve a shared layout, there are two copies of it: the
original shared layout that only you can view and modify (the reserved copy) and the original shared layout
that is still available to other authorized users. When you reserve a shared layout, no other authorized user can
reserve the same layout.

• Shared: Layouts that have been published and are available to all authorized users.
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Accessing the Framework Edit Mode  
To open the framework for editing, select a layout from the Layout drop-down list, and then click Edit Form Layout from
the EnterpriseOne Personalization menu. If you do not see the Edit Form Layout option, you do not have permission to
create content and layouts.

When the framework opens in edit mode, you see a toolbar and a workspace area that displays the enabled
EnterpriseOne form and any content that was created previously for the layout.

Understanding the Framework Edit Mode Toolbar  
Depending on the layout you select, the framework toolbar shows two icons on the left-hand side that are named:

• Create New Content: Enables you to create new content. When you click Create New Content, a popup window
displays the available types of content that you can create

• Edit Existing Content: Enables you to open and edit existing content. When you click Open Existing Content, a
popup window displays content that already has been created but is not included on the selected layout.

When you select a shared layout in the framework edit mode, the above two icons do not appear on the toolbar.

The icons (on the right-hand side of the toolbar) are available for all User Defined Objects (UDOs) and are discussed in
the   JD Edwards EnterpriseOne Tools Foundation Guide  .

See "Understanding the UDO Design Panel" in the   JD Edwards EnterpriseOne Tools Foundation Guide   .

For detail usage of these icons in the Composite Application Framework edit mode, see the provided link.

• Save: See Saving Content and Layouts

• Save As: See Saving Content and Layouts

• Request to Publish: See Publishing Content

• Reserve: See Modifying Layouts

• Delete: See Viewing Content Details

• Notes: See Modifying a Layout that is Rejected for Publishing

• About form Layout: Enables you to view the information about the enabled EnterpriseOne form.

• Close: Enables you to exit the Composite Application Framework edit mode and return to view mode.

If any of the icons are gray, the action is not available for the selected layout or is not available until you select another
action.

Understanding the Framework Edit Mode Workspace  
You can create content on a new layout or on an existing personal layout. If you select Create from the layout Name
drop-down list, only the enabled EnterpriseOne form appears on the workspace. If you select an existing layout from the
layout Name drop-down list, the framework shows the enabled EnterpriseOne form and all content that has been saved
on that layout.

You can create new content and you can reuse existing content. Reusable existing content can be retrieved by clicking
the Open Existing Content icon and dragging and dropping the desired content on to the workspace. In edit mode, you
can add, delete, and reposition content on a layout. If you select a shared layout to modify, you must reserve the layout
before you can make changes to it.

When you create and save content, the content appears in a content frame that you position vertically or horizontally on
the framework. All content must be saved to a layout. If you have publishing permission, you can request that the layout
be published so that it is available for other users who are authorized to use the enabled EnterpriseOne form on the
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Composite Application Framework. These are shared layouts. If you do not have publishing permission, you can create
content and layouts, but the layouts are available to you only. These are personal layouts.

Understanding Content Frames  
If you have permission to create content, you can create new content, and you can reuse existing content and place the
content on a new layout or on an existing layout. The system limits the number of content frames that you can embed
on a layout; however, this can be changed by your system administrator. Whether you create new content or reuse
existing content, you drag and drop the content template or the existing content to the framework. The workspace
shows a content frame that consists of three sections:

• Link Information

• What type of link

• When do you want to see the content frame

Understanding Link Information  
The Link Information section identifies the content that you are embedding on the Composite Application Framework
for the enabled form.

The name you enter in the Name field is the name of the content that shows on a shared layout when you retrieve
content using the Open Existing Content icon.

The information you enter in the Description field becomes the title of the content frame on the Composite Application
Framework, and this is the name that appears on the tab when a user minimizes the content frame. The Description
field is optional and if you do not enter information in this field, the content frame will not show a title for the content
frame on the Composite Application Framework, and the name of the tab when content is minimized will be the
information that was entered in the Name field.

You also identify the source where the system can find the content, such as a web page URL or the name of the
EnterpriseOne form that is to be embedded on Composite Application Framework. The source for Web pages and OBIEE
objects are URL addresses, and the source for EnterpriseOne forms is the application name such as P01012, which the
Address Book application.

The fields that are available for data entry in this section are different depending on the type of content that you are
creating.

Note: 

• Entering Web Page Link Information

• Entering Embedded EnterpriseOne Form Link Information

• Entering OBIEE Content Link Information

Understanding What Type of Link  
The What type of link section on the content frame enables you to map parameters from the content to the enabled
EnterpriseOne form. This section enables you to create a static link or a dynamic link.
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Creating a static link is the default option. If you choose the Static Link option, your content cannot be mapped to
the enabled EnterpriseOne form. When a user or an event rule process changes the enabled EnterpriseOne form, the
content information does not change.

The Dynamic Link option enables you to map a parameter from the content to a form-level field value or grid-row
column on the enabled EnterpriseOne form. If you create a dynamic link, when a user or an event rule process changes
the EnterpriseOne linked value, the content in the content frame is automatically updated to reflect information
associated with the change.

The system lists the content parameters that you can map in table format.

You can enter custom text in the Static Value field. The custom text is added at the end of one or more parameter
values. Custom text provides flexibility for defining the parameter value; for example, a web page URL parameter
accepts data like trackNum=TRACK123456; 123456 is a field value on the EnterpriseOne form, but the prefix TRACK
must be added as customized text before the field value 123456. You can change your custom text by clicking the
question mark beside the parameter value, change the text in the Static Value field, and then clicking the plus sign next
to the Static Value. Although there is no limitation to the size of the custom text, the text appears in the Parameter Value
column, and the width of this field is limited.

When you define multiple field values as dynamic, the value in the Separator field determines how the fields are
separated. The default value is a comma. If you do not want to use a separator, you can remove the value from the
Separator field. You can specify a different value as a separator.

Note: 

• Mapping Web Page URL Parameters to the EnterpriseOne Form

• Mapping Embedded EnterpriseOne Form Parameters to the Enabled EnterpriseOne Form

• Mapping OBIEE URL Parameters to the EnterpriseOne Form

Understanding When do You Want to See the Content Frame  
The When do you want to see the content frame section enables you to set conditions for showing the content frame
on the Composite Application Framework. Defining when to display the content is optional. The Always option is set by
default. The Always option shows the content on the framework regardless of the data in the enabled EnterpriseOne
form. When you select the Sometimes option, you identify EnterpriseOne form-level field values or grid-row columns
that tell the system when to show the content on the Composite Application Framework. The Sometimes option shows
the content on the Composite Application Framework only when the values entered in the EnterpriseOne form match
the conditional values that you define.

Note: 

• Setting Conditions for Displaying Web Page Content

• Setting Conditions for Displaying Embedded EnterpriseOne Forms

• Setting Conditions for Displaying OBIEE Objects
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Creating New Content  
You can create the following types of content:

• Web Page URLs

See Creating Web Page Content

• Embedded EnterpriseOne Forms

See Creating Embedded EnterpriseOne Form Content

• Oracle Business Intelligence Enterprise Edition (OBIEE) Objects

See Creating OBIEE Object Content

• Attachments (Tools Release 9.2.8.2)

See Creating a CafeOne Layout for the Media Object Viewer

After you create the content, you must save it to a layout and then save the layout. This becomes a personal layout.
If you request the layout be published, the layout appears on the Layout drop-down list (Name drop-down list in edit
mode) under the Pending Approval category. After the content is approved for publishing, the content appears on the
Layout drop-down list (Name drop-down list in edit mode) under the Shared category.

See Saving Content and Layouts

Reusing Existing Content  
Content that is on a shared layout is available for use on other layouts. Content can be used on a single layout only once
but can be used on multiple layouts. After you embed existing content on the working layout, it no longer appears in the
open existing list for that layout.

You access reusable content by clicking the Open Existing Content icon. From the content palette, you can click on the
desired content and drag and drop the content onto the workspace layout.

The palette shows each layout by layout name and whether the layout is a personal layout or a shared layout. Personal
layouts are viewable only to the user who created them. Personal layouts are listed first and then shared layouts. Each
layout is highlighted in blue. The content for each layout appears under the layout name. Within a layout, the content
is grouped by content type, with all web page URL content listed first, then all OBIEE object content, and then all
EnterpriseOne Form content. Within each content type, the content is listed alphabetically by the name that was entered
in the Name field when content was created. The description that is entered when the content was created appears on
the palette under the content name (this description is the name of the content frame on the Composite Application
Framework). The date and time that the content was created is also listed. You can use any content that is listed on the
palette, even if you did not create that content.
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Saving Content and Layouts  
After you create the content, click Save on the title bar of the content creation frame. This action places the content on
the layout in the framework workspace. If you decide you do not want to keep the content, click the Delete content icon
on the right-hand side of the content creation frame.

You can reposition content on the framework layout before you close the framework edit mode by placing your cursor
between two content frames or between a content frame and the enabled form (either horizontally or vertically) until a
thin blue line appears. Move the content to be repositioned right or left or up or down. You must be in the framework
edit mode to modify content and layouts.

If you created or reused content on a new layout (the name in the layout field is Create), you click the Save icon and
provide a name for the layout.

If you modified an existing personal layout (by adding, modifying, or deleting content that is on that layout, or
repositioning content on the layout), you can click either the Save or Save As icon. Clicking Save updates the original
personal layout with the changes. Clicking Save As requires you to enter a new layout name, so that you have the
original personal layout and a new personal layout with the updates you made.

If you close the framework edit mode without saving the layout, the system sends a warning message. If you click OK on
the warning message, any changes you made to the content or layout are cancelled.

After you save the layout, it appears on the layout drop-down list as a personal layout. If you have permission to publish
content, you can request that the layout be published, which places the layout in a pending approval state for approval
by your administrator.

Publishing Content  
Your administrator grants you permission to publish content. You publish content by sharing the layout that contains
that content.

In the framework edit mode, after you save your content to a layout, and save the layout, click the Request to Publish
icon. When you click Request to Publish, the system sends a confirmation message to verify that you do want to publish
the layout. The confirmation message also provides an opportunity for you to add notes for the layout approver. When
you click OK on the confirmation message, the layout is moved to Pending Approval status. If you click Cancel on the
confirmation message, you can make changes to the layout or to the content that is on the layout, and then save the
content and layout and request the layout be published.

Modifying Layouts  
You modify a layout by adding, modifying, or deleting content that is on that layout or by changing the layout (for
example, reposition content on the layout). You can modify a personal layout.

You can also modify the following layouts by reserving them, which makes them a personal layout, making the changes,
and requesting to publish:

• Layouts that are pending approval.

• Layouts that have been rejected for publishing.
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• Layouts that have been shared.

You must be in framework edit mode to modify a layout.

Repositioning and Resizing Content on a Layout  
After you create and save the content, you can reposition the content on the layout. You must be in the framework edit
mode to reposition content.

To reposition content:

1. In the title bar of the content that you want to reposition, click and hold the right or left mouse button down.
The content shows as a blue rectangle.

2. Drag the content to a different position on the layout.
3. Release the mouse button.
4. Make any other changes to the content or the layout.
5. Save the layout.

You can resize content on the layout when the framework is in edit mode. Any user who has access to the layout can
resize the content.

See Resizing Content Frames

Modifying a Personal Layout  
A personal layout is available for you only.

To modify a personal layout:

1. Select the personal layout that is to be modified from the Personal category on the Name drop-down list.
2. Make and save changes to content as desired.
3. Reposition and resize on the layout as desired.
4. Save the layout by doing one of the following:

a. Click Save.
This option saves the change on the original personal layout.

b. Click Save As and enter a new layout name.
This option saves the change on a new layout and keeps the original layout without the change.

5. Close the framework edit mode.

Modifying a Shared Layout  
You can modify a shared layout by reserving it. Reserving a shared layout results in a copy of the shared layout available
to you in the reserved category on the Name drop-down list. The original shared layout is still available to other users.

If you reserve a layout and then decide you do not want to change it, you can click the Unreserve icon. The original
layout is available as a shared layout.

When you select a shared layout in edit mode and the layout has been reserved for editing by another user, the title bar
indicates that the layout is reserved and user ID of the individual who reserved it. You cannot modify this shared layout.

When you select a shared layout in edit mode and the layout has been checked out of OMW, the title bar indicates that
the token is held in a project. You cannot modify this shared layout.

To modify a shared layout:

1. Open the Composite Application Framework in edit mode.
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2. Select the shared layout that you want to modify from the Shared category on the Name drop-down list.
3. Click the Reserve icon.

This action makes a copy of the shared layout available for you to edit. The original shared layout is still
available as a shared layout.

4. Make changes to content and layout as desired.
5. Save the layout by doing one of the following:

a. Click Save.

This option saves the change on the original layout.
b. Click Save As.

This option saves the change on a new layout and keeps the original layout intact as a personal layout.

Note:  You must save the layout before you click the Request to Publish icon. If you do not save the
layout, your changes will be lost and the original layout without your changes will be placed in Pending
Approval status.

6. Click the Request to Publish icon.
7. Close the framework edit mode.

Modifying a Layout that is Rejected for Publishing  
If your layout is rejected for publishing, the layout is returned to you and appears in the Name drop-down list in the
Rework category. Your approver can optionally send notes explaining why the layout was rejected for publishing. You
can view notes by clicking the Notes icon.

To modify a layout that was rejected:

1. Open the Composite Application Framework in edit mode.
2. Select the layout from the Rework category on the Name drop-down list.
3. Click the Reserve icon.

This action changes the layout to a personal layout so that you can modify it.
4. Make the changes to the content and layout as required.
5. Save the layout by doing one of the following:

a. Click Save.

This option saves the change on the original layout.
b. Click Save As and enter a new layout name.

This option saves the change on a new layout and keeps the original layout intact as a personal layout.

Note:  You must save the layout before you click the Request to Publish icon. If you do not save
the layout, your changes are lost and the original layout without your changes is placed in Pending
Approval status.

6. Click the Request to Publish icon.
7. Close the framework edit mode.
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Modifying a Layout that is Pending Approval  
You can modify a layout that is pending approval by reserving it and making the changes and resubmitting it for
approval. When you click the Reserve icon, the layout reverts to a personal layout. If you decide you do not want to make
changes, you can click the Unreserve icon, and the layout returns to pending approval.

To modify a layout that is pending approval:

1. Open the Composite Application Framework in edit mode.
2. Select the layout from the Pending Approval category on the Name drop-down list.
3. Click the Reserve icon.

This action changes the layout to a personal layout so that you can modify it.
4. Make the changes to the content and layout as required.
5. Save the layout by doing one of the following:

a. Click Save.

This option saves the change on the original layout.
b. Click Save As and enter a new layout name.

This option saves the change on a new layout and keeps the original layout intact as a personal layout.

Note:  You must save the layout before you click the Request to Publish icon. If you do not save
the layout, your changes are lost and the original layout without your changes is placed in Pending
Approval status.

6. Click the Request to Publish icon.
7. Close the framework edit mode.

Deleting Layouts  
You can delete personal layouts. When you delete a personal layout, the content on that layout is removed and the
content is no longer available unless it is used on another layout.

To delete a personal layout, select the personal layout from the Name drop-down list, and then click the Delete icon.

You cannot delete a shared layout. An OMW user can delete a shared layout.

Viewing Content Details  
Any user who has permission to create content and layouts can review the content details for existing content. The
content detail page is read only and shows the following information:

• Name of the content.

• Description of the content.

• Creator of the content.

• The source of the content (URL or application, form, and version).

• Whether the link is static or dynamic and if dynamic, the parameter values are highlighted.
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• Whether the content always shows on the Composite Application Framework or shows only when data on the
enabled form matches the conditional criteria. Conditional fields and values are in table format for reviewing.

To review the details of a content frame:

1. In the framework edit mode, select a layout that contains the content frame that you want to view.
2. Click the Detail icon on the left-hand side of the title bar.
3. After reviewing the content details, click Cancel on the content frame title bar.

Editing Content  
You can edit a content frame by changing the content name, description, content source (URL or application, form, and
version), dynamic parameters, and conditional criteria.

Note:  Although the OBIEE URL field appears to not be available for editing, you can click Search and then select a
different object on the OBIEE object window that pops up. This action replaces the existing content with new content,
and if you want dynamic links or conditions for displaying the content, you must reenter the information.

You can click Cancel to remove unsaved edits.

To edit content:

1. In the framework edit mode, select the layout that contains the content frame that you want to edit.
2. Click the Detail icon on the left-hand side of the content frame title bar.
3. Click the Edit icon on the left-hand side of the content frame title bar.

If you do not see the Edit icon, you do not have permission to modify the content
4. After making changes, click Save to save the change or click Cancel to return to the original content without the

changes.
5. On the framework title bar, click Save to save the original personal layout with the updates or click Save As to

create a new personal layout.

Deleting Content  
You must be in the framework Edit mode to delete content. When you delete content, ensure that you are on the correct
layout. The Delete Content icon, on the right-hand side of the content frame title bar shows a red X. To delete the
content from the personal layout, click the Delete Content icon.

Translating Content  
See "Translation" in the   JD Edwards EnterpriseOne Tools Using and Approving User Defined Objects Guide    for
information about translating content.
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4  Creating Web Page Content

Understanding Web Page Content Creation  

Note:  You may not be able to perform the tasks in this chapter on a mobile device.

Web page content can be linked to the enabled EnterpriseOne application form using a web page parameterized
URL. A parameterized URL contains parameters that are dynamic parts of the URL that can be linked to one or more
EnterpriseOne form-level field values or one or more grid-level columns. When a URL parameter is linked to an
EnterpriseOne application form-level field value or grid-level column, the content or reference of the URL is changed
when the value in the EnterpriseOne form-level field or grid-level column is changed.

Validating a Web Page URL  
Web page content and the EnterpriseOne form must be able to appear together in the same browser window on the
Composite Application Framework. The web page URL is implemented as an embedded iFrame. An iFrame is a website
that is embedded within another website with both websites appearing in the browser. Some websites implement code
to prevent other websites from embedding their website in an iFrame. The Composite Application Framework validate
function detects whether the URL you enter can be embedded in the EnterpriseOne form.

After you enter a URL in the web page link information section, clicking Validate triggers the validation process. If the
validation process finds that the URL and the enabled form can display together on a layout, the validation process
briefly displays the web page content in a separate window, and sends a message in a popup window stating that the
URL is successfully validated. This message means that the validation process was successfully completed; it does not
mean that the URL is valid.

Note:  Because of the many different ways a website can be built, the validation process cannot guarantee that the
URL you select will always be able to be embedded in the EnterpriseOne form especially if the website changes
dynamically. The result is an empty content frame even though you received the message indicating the URL
successfully validated.

If the validation process finds that the URL and the enabled form cannot display together on a layout, the validation
process displays a message in a separate window indicating that the content cannot be displayed in a frame. The
system does not prevent you from saving this URL, but the content frame will be empty.

Note:  Later versions of browsers (Internet Explorer, Firefox, Chrome) automatically block mixed content. Mixed
content occurs when you are running an HTML server in secure mode (HTTPS) and the child content that you want to
embed uses HTTP. When this happens, you might get an empty frame. You can disable the blocking feature. To obtain
instructions for disabling the block, search the Internet for your browser and the words mixed content (for example,
Internet Explorer mixed content, FireFox mixed content, Chrome mixed content).
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Creating Web Page Content  
You must be in the framework edit mode to create web page content. When you create web page content, ensure that
you provide sufficient area on the workspace to work with the content.

You should review the content of the URL you select to ensure it is legal and appropriate. You are responsible for
ensuring that the web page is not copyright protected; embedding a web page URL that is copyright protected is a legal
issue.

To create an empty frame on the framework workspace:

1. In the framework edit mode, select a layout from the Name drop-down list.
2. Click the Create New Content icon.

A popup window appears showing the kinds of content you can create.
3. Click the URL icon and drag and drop the empty frame that appears to the workspace.

You can position the empty frame horizontally or vertically on the framework workspace.
After you drop the empty frame on the workspace, the frame is named Create link to Web Page. The title bar includes a
Save icon and a Close icon. Clicking the Close icon before saving the content cancels the content. The Create link to Web
Page frame is grouped into three sections:

• Link Information

• What type of link

• When do you want to see it.

Entering Web Page Link Information  
The Link Information section identifies the web page. You must enter a valid URL in the URL field. If the URL field shows
a drop-down arrow, there are predefined URL templates from which you can choose and modify as required.

Note:  If you have web page URLs for which you frequently create content, you can add web page URL templates to
simplify the task of creating URL web page content. See Adding Web Page Templates for Creating Content

You have the option of validating the web page URL when you enter link information, and Oracle recommends that
you do this. In addition, the system automatically validates the web page when you save the web page content. The
validation function attempts to identify web pages that cannot be embedded with the enabled form.

Follow these rules when entering a URL:   

• The URL must start with http:// or https://.The URL must be to a trusted web page.
Embedding links to only trusted web pages helps to avoid the introduction of undesirable content into JD
Edwards EnterpriseOne.

• The URL must be able to be rendered within the browser.

• The URL must not be to a web page that has content that is copyright protected.

• The URL must not be to the JD Edwards EnterpriseOne HTML server.
This could cause JD Edwards EnterpriseOne to malfunction.
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You must enter a name for the content. The name that you enter can be up to 30 characters.

Entering a description is optional. The description that you enter appears on the title bar of the content frame when the
content is saved. If you do not enter a description, the content frame will not have a name when it is displayed on the
Composite Application Framework.

After you enter the link information, you can click Save on the content frame title bar to create the content, or you can
map parameters or define conditional criteria. If you save the content after you enter the link information, you can add
mapping and conditional criteria by editing the content.

See Editing Content

Mapping Web Page URL Parameters to the EnterpriseOne Form  
The What type of link section determines whether content remains constant or changes when a value in a mapped
field on the EnterpriseOne form changes. The web page URL that you entered in the Link Information area is called a
template URL or a parameterized URL and is used by JD Edwards EnterpriseOne to generate parameters that you can
map to the EnterpriseOne form-level field values or to a grid-row column.

The type of link is set to Static Link by default. This means that the web page content is constant and does not change.

When you select Dynamic Link, the JD Edwards EnterpriseOne system formats the URL candidate contextual
parameters into table format, and the original URL appears at the bottom of the content creation pane. The URL
parameter table format consists of three columns:

• The Parameters column lists the URL parameters.

• The Operation column provides a drop-down list from which you choose whether to map a parameter to a field
on the current EnterpriseOne form or leave it as is.

• The Parameter Value column shows the data dictionary item and name of the field that you map to the
parameter. You can add multiple fields as well as custom text in the Parameter value column.

To map URL parameters to EnterpriseOne form-level fields:

1. In the What type of link section, select the Dynamic Link option.
2. Select a URL parameter and change the Operation column to is mapped to.

This action starts the capture mode. During the capture phase, a key indicator, which appears as a gold plus
sign, shows the form fields or grid rows or columns that you can select.

A valid form-level field is a text field and value in the header area of the form. Data privacy fields, password
fields, hidden text, and fields with wildcard values cannot be mapped.

Starting with Tools release 9.2.2.5, check boxes and combo boxes (drop-down lists) in the header area of the
form are also valid form-level fields that can be mapped. And if in the grid, they are valid grid columns that can
be mapped.
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3. Click the plus sign beside a valid form-level field, grid column, or the custom text.

You can map multiple fields as one parameter. For example, you might use the Address Line 1, City, State, and
Postal Code fields as the address parameter. If you use a separator, the fields are separated by the defined
separator.

You can click the plus sign beside the Static Value field value in the content frame to add your custom text to
the parameter.

See Understanding What Type of Link for more information about using the Static Value field.

To delete a parameter value, hover over the value and then click the Delete icon that appears beside it.

The value of the form-level field or grid column and any custom text appears in the web page URL at the
bottom of the creation pane. The EnterpriseOne form-level field or grid column and custom text in the
Parameter Value column and the mapped value in the URL are highlighted. The custom text and the separator
are highlighted only when viewing or editing the content.

If you map a contextual parameter, but decide that you want to reset the parameter back to the original default
mapping, change the corresponding mapping option back to remain as. If you want to see the original URL
parameter, select the remain as operation for that parameter.

If you create a dynamic link and later decide that you want to change the original URL, but it is not available,
select the Static Link option.The original URL appears and is editable.

Setting Conditions for Displaying Web Page Content  
The When do you want to see it section determines whether the specific content you are creating always appears on
the Composite Application Framework when this EnterpriseOne application form is opened or if this content appears
only when specified values are entered on this EnterpriseOne application form. The Always option is set by default. This
means that this content always shows in the Composite Application Framework when this form is opened.

When you select the Sometimes option, you define the values that must be entered in the EnterpriseOne form for this
content to appear on the Composite Application Framework.

To specify conditional criteria for when the link displays:

1. In the When do you want to see it section, select the Sometimes option.
2. Click the Define the conditional data for displaying this content frame.

This action starts the capture mode. During the capture phase, a key indicator that appears as a plus sign
shows the fields and grid column headers on the application form that you can select. A valid form-level field is
a text field and value in the header area of the form. Data privacy fields, password fields, hidden text, and fields
with wildcard values cannot be mapped.

Starting with Tools release 9.2.2.5, check boxes and combo boxes (drop-down lists) in the header area of the
form are also valid form-level fields that can be mapped. And if in the grid, they are valid grid columns that can
be mapped.
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3. Click the plus sign beside a valid form-level field or the grid column header on the open EnterpriseOne form.

You can select one or more text fields and their values and grid columns on the application form to create the
conditional criteria that define when this content should appear on the Composite Application Framework when
this application form is opened.

As you capture fields, the system displays a table of the descriptions, data dictionary aliases, and the value of
the fields that you selected.

4. After you complete the conditional link definition process, click the Stop icon.

Saving the Web Page Content  
You create the content by clicking the Save button on the content frame title bar and saving the layout. This creates a
personal layout.

See Saving Content and Layouts

You can perform the following actions on a personal layout:

• Add content by creating new content and saving it on the existing layout or create a new personal layout.

See Creating New Content

• Add content by reusing existing content and saving it on the existing personal layout or create a new personal
layout.

See Reusing Existing Content

• View content details.

See Viewing Content Details

• Edit content.

See Editing Content

• Delete content.

See Deleting Content

• Reposition the content on the layout.

See Repositioning and Resizing Content on a Layout

• Resize the content on the layout.

See Resizing Content Frames

• Delete your personal layout.

See Deleting Layouts
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Publishing Content  
If you have permission to publish content, you can request that the personal layout that you created be shared with
other authorized users by clicking the Request to Publish icon. After the layout is approved, it becomes a shared layout.

See Publishing Content

Assuming you have permission, you can perform the following actions on a shared layout:

• Modify a shared layout.

See Modifying a Shared Layout

• Modify a layout that is rejected for publishing.

See Modifying a Layout that is Rejected for Publishing

• Modify a layout that is pending approval.

See Modifying a Layout that is Pending Approval

• Add content by creating new content and saving it on the existing shared layout and request the layout be
published or create a new personal layout and request the personal layout be published.

See Creating New Content

• Add content by reusing existing content and saving it on the existing shared layout and request the layout be
published or create a new personal layout and then request the personal layout be published.

See Reusing Existing Content

• View content details.

See Viewing Content Details

• Edit content.

See Editing Content

• Delete content.

See Deleting Content

• Reposition the content on the layout.

See Repositioning and Resizing Content on a Layout

• Resize the content on the layout.

See Resizing Content Frames

Note:  You cannot delete a shared layout.
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Adding Web Page Templates for Creating Content  
When you create a web page URL template, the template appears on the URL drop-down list in the Link Information
section. The template then populates the name, description, and web page URL. The web page URL template is
available to any authorized user for the enabled form.

You use the Media Object Queues (P98MOQUE) application to add web page templates. You can type P98MOQUE in the
Fast Path or use this path to navigate to the Related Information applications:

Navigator > EnterpriseOne Menus > EnterpriseOne Life Cycle Tools > System Administration Tools > Media Object
Administration > Media Object Queues

Note:  If you cannot access the Media Object Queues (P98MOQUE) application, contact your EnterpriseOne
administrator.

To add a web page URL template:

1. Access the P98MOQUE application.
2. Click Add.
3. Enter a short name for the web page URL template in the Queue Name field (for example, Map)

This populates the URL field when you create new content using a web page template.
4. Enter the web page URL in the Queue Path On-Line field.

This populates the URL field when you create new content using a web page template.
5. Enter a description for the URL in the Queue Path Off-Line field.

This populates the Description field when you create new content using a web page template.
6. Enter 10 (RIAF URL Template) in the Type field.

Note:  If the value 10 (RIAF URL Template) is not available, you may need to add it to the H91/QT UDC table.

7. Click OK to save your record.
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5  Creating EnterpriseOne Form Content

Understanding Embedded EnterpriseOne Form Content  

Note:  You may not be able to perform the tasks in this chapter on a mobile device.

You can embed any EnterpriseOne application form on a layout. Message forms such as warning messages and
subforms cannot be embedded on a layout. You can embed the same EnterpriseOne form multiple times on a layout;
however, you must map different parameters or conditional settings. Embedded forms allow limited functionality. Form
interconnects and row exits do not work on the embedded EnterpriseOne form.

With Release 9.2.1, you can embed external forms on a layout. However, you cannot embed external forms that have an
external application type of Composed Page. Only external forms using ADF or JavaScript (JET) can be embedded on a
layout as an enabled EnterpriseOne form.

The enabled form is fully functional. Users who have access to the enabled form can access other forms through form
interconnects and row exits, add new records, find existing records, copy records, delete records, and so on. With
Release 9.2.1,you can also map the Personal Forms on the layout.

The embedded forms have limited capability. All standard EnterpriseOne embedded forms provide Save and Refresh
capability. Some embedded forms provide additional capability. Form interconnects and row exits do not work on an
embedded form, meaning that a user cannot access another form from the embedded form. With Release 9.2.1, if the
embedded form is an external form, functionality will vary.

Depending on how you design embedded forms, users who have access to the layout on the Composite Application
Framework can do the following:

• Browse available information on embedded forms by selecting a header field or different grid row on the
enabled form.

• Update a field on the enabled form, and the change is made on all linked embedded forms.

• Update a field on the embedded form. Upon saving the change, the EnterpriseOne database is updated.
Clicking Find on the enabled form refreshes all of the embedded forms that are mapped to the enabled form
and embedded forms display the change.

• Create new records.

• Embed a Personal Form associated with an EnterpriseOne application form. (Release 9.2.1)

Standard security applies to all EnterpriseOne forms on the Composite Application Framework. If you are secured out of
a specific EnterpriseOne form, you cannot access it on the Composite Application Framework.

Creating Embedded EnterpriseOne Form Content  

Note:    Click here to view a recording that shows how to access the framework edit mode, create embedded
form content that is dynamically linked to the enabled form and has conditional settings for displaying the

content, is placed on an existing shared layout, and is requested for publishing.
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You must be in the framework edit mode to create embedded EnterpriseOne form content. When you create
EnterpriseOne form content, ensure that you provide sufficient area on the workspace to work with the content.

To create an empty frame on the framework workspace:

1. In the framework edit mode, select a layout from the Name drop-down list.
2. Click the Create New Content icon.

A popup window appears showing the kinds of content you can create.
3. Click the EnterpriseOne Form icon and drag and drop the empty frame that appears to the workspace.

You can position the empty frame horizontally or vertically on the framework workspace.
After you drop the empty frame on the workspace, the frame is named Create link to Embedded EnterpriseOne Form.
The title bar includes a Save icon and a Close icon. Clicking the Close icon before saving the content cancels the content.
The Create link to Embedded EnterpriseOne Form frame is grouped into three sections:

• Link Information

• What type of link

• When do you want to see it

Entering Embedded EnterpriseOne Form Link Information  
The Link Information section identifies the embedded EnterpriseOne form.     

Note:

You can only add one embedded EnterpriseOne form that is an external form with an external application type of ADF.
(Release 9.2.1)

You cannot add an embedded EnterpriseOne form that is an external form with an external application type of
Composed EnterpriseOne Page.Release 9.2.1)

If adding an embedded EnterpriseOne form that is an external form with an external application type of JavaScript,
you will see a Show Title Bar option. (Release 9.2.1)

To enter link information:

1. Enter the Application ID of the embedded form and press Tab.

You can enter any EnterpriseOne application ID. The application ID is the program number, for example, P01012
for Address book, P4210 for Sales Order, and so on.

After pressing Tab, the system populates the remaining fields in this section. You can change the system-
entered information.

2. From the Form drop-down list, select the EnterpriseOne form that you want to embed in the layout.

The forms that are available for embedding on a layout depend on the EnterpriseOne application that you
entered and are based on the EnterpriseOne data structure for form interconnects. The available forms are
listed alphabetically. The system automatically enters the first listed form in the Form field. These are the only
forms you can embed for the application that you entered.

Standard security applies to the embedded EnterpriseOne forms. If you are secured out of an EnterpriseOne
form, then the form does not show on the Form drop-down list.
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3. From the Version drop-down list, select the application version.

The system searches system table F983051 for available versions for the application ID that you entered. The
available versions are listed alphabetically. The system automatically enters the first listed version in the Version
field. You must use a version from the Version drop-down list.

4. From the Personal Forms drop-down list, select the personalized form that you want to embed in the layout.
(Release 9.2.1)

The system lists all the available Personal Forms for the version that you entered. The available Personal Forms
are categorized as: Personal, Pending Approval, Rework, Reserved, and Shared.

Note:  Personal Forms drop-down list will be displayed only if the Personal Forms Feature Security is enabled.

5. Enter a name for the content frame.

This is a required field. The system automatically enters and updates this field with the Application ID, form ID,
and version ID that are entered in the previous fields. You can change this entry to a more meaningful name.
The name that you enter can be up to 30 characters.

The name that you assign the content frame appears on the Open Existing Content palette.
6. Enter a description for the content frame.

This is an optional field. The system automatically enters and updates this field with the values that are in the
Form and Version fields. You can change this entry to a more meaningful name, or you can leave this field
blank. The description that you enter can be up to 100 characters.

The description that you provide appears on a layout as the name of the content frame. If the Description field
is blank, the system automatically uses the value that you entered in the Name field as the name of the content
frame.

You can use the description to provide information about the content frame. For example, if you design the
content frame to appear on the layout only when the value in the Search Type field of the enabled form is equal
to C (customers), you might want to provide the form name and the conditional setting. For example, your
description might be "Who's Who-Display when Search Type=C)".

7. Select or clear the Automatically Find on Entry Option.

If you are embedding a Find/Browse form, the Automatically Find On Entry option appears on the form. The
option is automatically selected. This option populates the Find/Browse form without the user clicking Find. If
you clear this option, the user must click Find to populate the form.

8. Select or clear the Maximize Main Grid Option

If the embedded form has a Maximize Grid icon on the grid header bar, the Maximize Main Grid option appears
in the Link Information section. Subforms cannot be embedded on a layout. When both the Automatically find
on entry and the Maximize Main Grid options are selected, the embedded form's grid with records appears in
the content frame when you save the content. The embedded form header information does not appear. After
you save the content, you can click the Restore Grid icon in the grid header bar to see the entire embedded
form. If you select the Maximize Main Grid option but don't select the Automatically find on entry option, when
you save the content, only the grid header bar with no records shows in the content frame.

9. Select or clear the Show Title Bar option. (Release 9.2.1)

If you are embedding an external form that has an external application type of JavaScript (JET), the Show Title
Bar option appears on the form. Use this option to show or hide the title bar of the JET application.

After you enter the link information, you can click Save to create the content, or you can continue with another section.
If you save without mapping parameters on the embedded form to the enabled EnterpriseOne form, the embedded
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form appears on a layout as an empty form. This empty embedded form can be used to create and save new records. If
you save without entering conditions for displaying this content, the content always displays when this EnterpriseOne
form is opened, regardless of the information on the EnterpriseOne form.

If you save the content after you enter the link information, you can later map parameters and define conditions for
displaying this content by editing the content.

Mapping Embedded EnterpriseOne Form Parameters to the
Enabled EnterpriseOne Form  
The What type of link section enables you to map parameters from the embedded EnterpriseOne form to the enabled
EnterpriseOne form. If you select the Static Link option, the embedded form appears on the layout without any data. If
the embedded form is a Fix/Inspect form, users can use the form to add new records to the EnterpriseOne database.    

When you select the Dynamic Link option, you can map parameters from the embedded form to the enabled form.
If you map an embedded form parameter to a header field on the enabled form, when a new value is entered into
the mapped field on the enabled form and the user clicks Find, the system updates the embedded form to show
information that is relevant to the new value.

If you map an embedded EnterpriseOne form parameter to a grid column on the enabled form, when a user selects
a different row, the embedded EnterpriseOne form is automatically updated to show information relevant to the row
record.

Mapping parameters from the embedded form to the enabled form is done the same way as mapping Web URL
parameters. For detailed steps to map the parameters, see Mapping Web Page URL Parameters to the EnterpriseOne
Form.

Mapping Parameters to the Enabled Form  
The system determines the parameters that are available for mapping. These parameters are based on the
EnterpriseOne data structure for form interconnects. This data structure is used to pass values to and from the
form. In order to make valid and useful mappings, it is important that you understand how EnterpriseOne forms are
designed. For more information about form data structure interconnects, see "Working with Forms" in the    JD Edwards
EnterpriseOne Tools Form Design Aid Guide   .

The following list provides some information about parameter mappings:

• You can map more than one parameter on the embedded form to the enabled form.

• You can embed the same form multiple times; however, each embedded form must have different criteria for
displaying information.

Note:  Each embedded form depends on its own event rule (ER) logic. This means that each embedded form
may behave differently, even if it is the same form with different mappings. Even different versions of the
same form may behave differently when the same or different fields are mapped.

• Ensure that you map the same data types (such as character, numeric, string, date).

If you try to map parameters and fields that are different data types, the system sends a warning message
indicating that this mapping may not work.

The warning message is based on a very generic set of rules. If you try to map fields that cross the type
categories, the system applies the rules and sends the warning message. The system cannot always validate
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fields, even if the data type is the same. It is important that you test the embedded forms to ensure they work
as you expect them to work.

Setting Conditions for Displaying Embedded EnterpriseOne Forms
 
The When do you want to see it section determines whether the embedded EnterpriseOne form always appears on the
layout when the enabled EnterpriseOne application form is opened or if this content appears only when specified values
are entered on the enabled EnterpriseOne application form. The Always option is set by default, which means that the
embedded EnterpriseOne form always shows on the layout when this enabled EnterpriseOne form is opened.   

When you select the Sometimes option, you define the values that must be entered in the enabled EnterpriseOne form
for this content to appear on the layout.

Defining conditional criteria for displaying the embedded EnterpriseOne form is done the same way as defining
conditional criteria for displaying web page URL content. For detailed steps to define conditions for displaying the
embedded form, see Setting Conditions for Displaying Web Page Content.

Saving Embedded EnterpriseOne Form Content  
You create the content by clicking the Save button on the content frame title bar and saving the framework layout.

See Saving Content and Layouts

Repositioning and Resizing Embedded EnterpriseOne
Form Content on the Layout  
After you create and save content, you can reposition and resize the content on a layout while the framework is in edit
mode.

See Repositioning and Resizing Content on a Layout

Publishing Content  
See Publishing Content
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Troubleshooting Content (Release 9.2.1)  
If using Microsoft Internet Explorer 11 and you see the following message when using an external form with the
JavaScript (JET) external application type, turn off the XSS filter for trusted sites in Internet Explorer 11 to fix the issue.
The message you may see is, "Internet Explorer has modified this page to help prevent cross-site scripting."
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6  Creating Oracle Business Intelligence
Content

Understanding Oracle Business Intelligence Content  

Note:  If your enterprise uses Oracle Business Intelligence, configure your system for Oracle BI Enterprise Edition
(OBIEE) before you perform the tasks in this section. See Configuring a Business Intelligence Connection

Typically, organizations track and store large amounts of data about products, customers, prices, contacts, activities,
assets, opportunities, employees, and other elements. This data is often spread across multiple databases in different
locations with different versions of database software.

After the data is organized and analyzed, it can provide an organization with the metrics to measure the state of its
business. This data also can present key indicators of changes in market trends and in employee, customer, and partner
behavior. Oracle Business Intelligence (Oracle BI) helps users obtain, view, and analyze the data.

Oracle BI Applications is a prebuilt business intelligence solution that supports Oracle sources, such as Oracle E-
Business Suite Applications, Oracle's Siebel Applications, Oracle's PeopleSoft Applications, Oracle's JD Edwards
Applications, and non-Oracle sources, such as SAP Applications. If you already own one of these applications, you can
purchase Oracle Business Intelligence Enterprise Edition (OBIEE) and Oracle BI Applications to work with the application.

Oracle BI Applications also provides complete support for enterprise data, including financial, supply chain, workforce,
and procurement and spend sources. These enterprise applications typically source from both Oracle data sources, such
as Oracle EBS and JD Edwards and non-Oracle data sources.

By creating OBIEE content frames, you can provide users quick access to this data from within enabled JD Edwards
EnterpriseOne applications.

Creating OBIEE Object Content  
OBIEE objects are available only when Oracle BI Enterprise Edition and the Oracle BI Applications adapter for
EnterpriseOne are installed and setup for your environment. To create and use OBIEE Object content, you must have
access to the OBIEE server. When you create new OBIEE object content, be sure to provide sufficient area on the
workspace to work with the content.

To create an empty frame on the framework workspace:

1. In the framework edit mode, select a layout from the Name drop-down list.
2. Click the Create New Content icon.

A popup window appears showing the kinds of content you can create.
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3. Click the OBIEE icon and drag and drop the empty frame that appears on the workspace.

You can position the empty frame horizontally or vertically on the framework workspace.

After you drop the empty frame on the workspace, a Select OBIEE object window appears showing a list of
shared folders.

4. On the Select OBIEE object window, click the name of the shared folder for which you want to create OBIEE
content.

If additional folders appear on the Select OBIEE object window, continue to navigate through the folders until
you find the object that you want to use for the content.

5. After finding the object that you want to use, click Select on the title bar of the Select OBIEE object window.

Note:  If you receive a message indicating that OBIEE content cannot be displayed in an iFrame, you should disable
iFrame busting. See Disabling iFrame Busting

After you select the OBIEE object, the frame on the workspace is named Create link to Oracle Business Intelligence Page
and contains the OBIEE link information. The workspace content frame also has Save and Close icons in the title bar.
Clicking the Close icon before saving the content cancels the content. Depending on the type of OBIEE object you select,
the Create link to Oracle Business Intelligence Page is grouped into two or three sections:

• Link Information

• When do you want to see it

• What type of link

For OBIEE content, the What type of link section appears if you select an OBIEE Answer instead of an OBIEE
Dashboard Page.

Entering OBIEE Content Link Information  
The system enters the OBIEE link information for the OBIEE object that you select. The Link Information identifies the
OBIEE object page. The system enters the name of the OBIEE object in the Name field. You can change the name. The
system enters the name of the OBIEE object in the Description field. You can change the description information or
remove it. The information that is in the Description field appears on the title bar of the content frame when the content
is saved. If you remove the description entry, the content frame does not have a name when it is displayed on the
Composite Application Framework. The system enters the OBIEE object URL. To change the URL field, click the Search
icon to open the Select OBIEE object form again and choose another OBIEE object.

After entering the link information, you can click Save to create the content, or you can continue with another section. If
the What type of link section is available, and you save the content without mapping URL parameters to EnterpriseOne,
the OBIEE object content becomes a static resource and does not change dynamically when users change the
information on the application form. If you save without entering conditions for displaying this content, the content
always appears when this EnterpriseOne form is opened. If you save after you enter the link information, you can later
map URL parameters and define conditions for displaying this content by editing the content.

Mapping OBIEE URL Parameters to the EnterpriseOne Form  
When you select an OBIEE Dashboard object, the What type of link section does not appear in the workspace content
frame. You cannot create dynamic links for OBIEE Dashboard content.   
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If you select an OBIEE Answer instead of an OBIEE Dashboard page when creating your OBIEE object content, you have
the opportunity to create dynamic links. When you select an OBIEE Answer object, the type of link is set to the Dynamic
Link option by default. The Dynamic link option enables you to map the OBIEE URL parameters to the EnterpriseOne
form. The system automatically formats the OBIEE Answer URL parameters into table format. The table shows these
columns:

• Parameters

This column lists the parameters that you can map to the open EnterpriseOne form or to customize text.

• Operation

This column provides a drop-down list that shows options for mapping the parameter to the open
EnterpriseOne form or to customized text:

◦ top

◦ bottom

◦ equal

◦ not equal

◦ less

◦ greater or equal

◦ less or equal

◦ between

◦ in the list

◦ begins with

◦ ends with

◦ contains all

◦ contains any

• Parameter Value

The column shows the data dictionary item and name of the EnterpriseOne field that is mapped to the
parameter. You can add multiple fields as well as custom text in the Parameter Value column.

To map parameters:

1. In the What type of link section, verify that the Dynamic Link option is selected and that the parameter table
appears.

2. Optionally enter text that you want to map to in the Custom Text field.
3. Select one of the parameters.
4. Change the Operation column to the desired value.

This action starts the capture mode. During the capture phase, a key indicator, which appears as an orange
plus sign, shows the fields or grid rows or columns that you can select. The key indicator also appears in the
Customized Text field on the content frame, making it available for selection.
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5. Click the plus sign beside a valid field or grid row or column on the open EnterpriseOne form or click the
Custom Text field.

A valid field is a text field and value on the form. Data privacy fields, password fields, hidden text, and fields
with wildcard values cannot be mapped.

You can change the custom text by clicking the question mark beside the parameter value, change the text in
the custom Text field, and then click the plus sign next to the Custom Text value.

To delete a parameter value, hover over the value and then click the Delete icon that appears beside it.
6. After you finish mapping a parameter, the contextual parameter indicator, which is an orange highlight,

appears in the parameter value field in the mapping area.
7. When you are finished mapping parameters, click Save or select an option in the When do you want to see it

section.
When you map parameters to the EnterpriseOne form, the Composite Application Framework shows an orange
highlight bar on the EnterpriseOne form and in the title bar of the content frame, indicating that content in the content
frame is specifically mapped the EnterpriseOne form.

Setting Conditions for Displaying OBIEE Objects  
The When do you want to see it section determines whether this content always appears on the Composite Application
Framework when this EnterpriseOne application form is opened or if the content appears only when specified values are
entered on this EnterpriseOne application form.

Specifying conditional criteria for when content is displayed on the Composite Application Framework is done the same
way for both OBIEE content and web page content.

See Setting Conditions for Displaying Web Page Content

Saving OBIEE Content  
You create the content by clicking the Save button on the content frame title bar and saving the framework layout.

See Saving Content and Layouts

Repositioning OBIEE Content on the Layout  
After you create and save content, you can reposition and resize the content on a layout while the framework is in edit
mode.

See Repositioning and Resizing Content on a Layout
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Publishing Content  
If you have permission to publish content, place the content on a layout and click the Request to Publish icon. Your
administrator approves and publishes the layout.

See Publishing Content
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7  Configuring a Business Intelligence
Connection or an Oracle Analytics Server
Connection

Configuring a Business Intelligence Connection  
This section is applicable only if your enterprise uses OBIEE reports.

Understanding Oracle BI Enterprise Edition  
Oracle BI Enterprise Edition (OBIEE) users are set up separately from EnterpriseOne users. Within EnterpriseOne, a
system administrator can set up different securities to control a user's access to certain applications or functionality.

Oracle BI Enterprise Edition has various granularities of security at the folder, report, and data level, which are not
provided by EnterpriseOne. EnterpriseOne only controls how to map a user to the Oracle BI user defined by the soft
coding values.

When a EnterpriseOne user is viewing OBIEE content, the system uses the mapped Oracle BI Enterprise Edition user
account to set up the connection and authentication with the Oracle BI Application Server. Any security setup for that
Oracle BI Enterprise Edition user is enforced by the Oracle BI Application Server. For example, the user could navigate
from an assigned root folder to another subfolder or could navigate to a dashboard from an action link on a report. It is
the administrator's responsibility to protect sensitive objects and data on the Oracle BI Application Server by using the
access control list provided by Oracle BI Application Server. This protection is highly recommended.

For more information on setting up access control for BI catalog items, see the Oracle Business Intelligence Presentation
Services Administration Guide.

Understanding the BI Connection Configuration  
All of the OBIEE reports are located on the Oracle BI Application Server. In order to connect to the Oracle BI Application
Server, one or more BI connections must be created for the users. Before you can create BI connections, you create a BI
connection template.

A BI connection defines how the system connects to the Oracle BI Application Server for any given EnterpriseOne user.
A BI connection includes information about the server, the port of the Oracle BI application server, the Oracle BI user
and password used to establish the connection, and the root folder (optional). A BI connection can be added for any
valid EnterpriseOne user, role, or *PUBLIC. They represent three different levels of mapping. An administrator can
create one BI configuration for *PUBLIC to cover all of the EnterpriseOne users or create multiple BI connection records
to perform mapping at various levels. If multiple BI connection records are created, the system uses the following rules:

• The system uses the most specific BI connection configuration (user>role>public).

• When the user logs in with a role of *All, the system prioritizes all roles of the user based on role sequence.
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Adding a BI Connection  
Use the Web Service Soft Coding Template (P953000) application to create a connection to the Business Intelligence
server. You can type P953000 in the Fast Path or use this path to navigate to the Soft Coding applications:

Navigator > EnterpriseOne Menus > EnterpriseOne Life Cycle Tools > System Administration Tools > Soft Coding
Administration

To add a BI Connection template:

1. Access the P953000 application
2. Click Add.
3. Enter BI CONNECTION in the Template Name field.
4. Enter BI Connection in the Description field.
5. Enter BI_CONNECTION in the SoftCoding Key field.

Note:  The value for SoftCoding Key must be BI_CONNECTION. You cannot use any other value for this field.

6. Enter the following in the Value field:

<webservice>
<endpoint>
http://server:port/analytics/saw.dll?SoapImpl=</endpoint>
<username>username</username>
<password>_||_BI_PASSWORD_||_</password>
<properties>
<property><name>root catalog</name><value>root catalog
folder</value></property>
</properties>
</webservice>

7. Enter the Mask Fields in the grid (for example, BI_PASSWORD).

Mask fields are the fields that have _ | | _ as a prefix and postfix. However, you do not include the prefix and
postfix when entering the mask field in the grid. The system adds the prefix and postfix for you.

8. Click OK to save the template.

Softcoding Value Guidelines  
When creating the BI connection template, use the following guidelines to ensure valid softcoding value parameters.

Http Address  
The http address must follow this format with a valid Oracle BI Application Server name or IP address and port number:

http://<server>:<port>/analytics/saw.dll?SoapImpl=

Username  
The user name must be a valid Oracle BI user name.
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_||_BI_PASSWORD_||_  
You have two ways to supply the password for the Oracle BI user:

• Use a placeholder parameter (masked parameter) in the softcoding value and assign the value to the
parameter in the grid. The above example used a placeholder parameter called BI_PASSWORD and defined the
BI_PASSWORD variable in the grid. The _ | | _ prefix and postfix are markers for placeholder variables.
When used this way, the value is encrypted before it is saved into the database and is masked for future display.

• Use plain text directly in the softcoding value.

Root Catalog  
The root catalog provides the default entry point folder when a user launches the BI catalog to create OBIEE content. By
default, this folder could be the root folder, which is a forward slash (/) in the template. However, for security reasons,
accessing the BI catalog at the root level may not be allowed in production. You should use a more specific path instead.

Note:  Within the <property> tags, the <name> must be root catalog because this is the hard-coded name in the
system. If you use another name, the system ignores it. Only the <value> element is configurable.

There are two ways to define the root catalog:

• Log into the Oracle BI Application Server and click the Catalog tab and then the Manage Catalog button. The
Manage Catalog window appears with the navigation link start from root folder "/". Drill up or down by clicking
the parent or child links. When you find the folder location that you want to use as the root catalog for the
EnterpriseOne end user, manually enter the folder path (for example, /shared/SampleSales) as the softcoding
value for root catalog. The path is case sensitive. Make sure that you type the exact folder path. If the path is
misspelled, EnterpriseOne fails to open the path. If you need to change the value for the root catalog, you must
correct the value in P954000 and restart the HTML server to clean up the cached information.

• The second approach can help you avoid typographical errors. You can use value "/" for initial testing if the
mapped Oracle BI user has permission to access the root folder.

Creating a BI Connection  
Use the Soft Coding Records (P954000) application to create a connection to the Business Intelligence server. You can
type P954000 in the Fast Path or use this path to navigate to the Soft Coding applications:

Navigator > EnterpriseOne Menus > EnterpriseOne Life Cycle Tools > System Administration Tools > Soft Coding
Administration

To create a BI connection:

1. Access the P954000 application.
2. Click Add.
3. In the User/Role field, enter the EnterpriseOne user, role, or *PUBLIC.
4. In the Environment Name field, enter the EnterpriseOne environment for which you are creating this BI

connection.
5. In the Template Name field, enter BI CONNECTION.
6. In the Soft Coding Key field, enter BI_CONNECTION.
7. Click the Populate Soft Coding Value button to populate the Soft Coding Description and Soft Coding Value

fields with the information from the BI CONNECTION template.
8. Change the user name and root catalog in the Soft Coding Value for your connection.
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9. Enter the Mask Value for any Mask Fields. For example, enter a value for BI_PASSWORD. You do not need

to use the prefix and postfix values (_ | | _) when entering the mask field in the grid. The system adds these
automatically.

10. Click OK to save the record.

Enabling Oracle Business Intelligence Objects  
Any EnterpriseOne user who should have access to OBIEE content, either to create or view the content, must have
access to the OBIEE server.  

Use these steps to set up user access to the OBIEE server.

1. Install the latest update of EnterpriseOne Tools.
2. Install the latest version of Oracle BI Enterprise Edition and the Oracle BI Applications adapter for

EnterpriseOne.

Note:  Releases prior to Oracle BI Enterprise Edition 11g are not supported.

3. Set up Oracle BI Enterprise Edition user groups and security.
4. Set up the EnterpriseOne user and roles.
5. Set up mappings between the EnterpriseOne user and roles to the Oracle BI Enterprise Edition user.
6. Inform users about their access to OBIEE reports (content creators and content users).

For more information on setting up users and groups in Oracle BI Enterprise Edition, see the   Oracle® Fusion
Middleware System Administrator's Guide for Oracle Business Intelligence Enterprise Edition  .

Disabling iFrame Busting  
The Oracle BI Enterprise Edition (OBIEE) automatically enables iFrame busting. When a user receives a system message
indicating that OBIEE content cannot be displayed in an iframe, you can use the following steps to disable iFrame
busting: 

1. Stop all OBIEE services.
2. Edit the instanceconfig.xml file.
3. Edit the web.xml file
4. Restart all OBIEE services.

Note:  Ensure that you are editing the correct locations of the files.

Editing the instanceconfig.xml File  
After you stop all of the OBIEE services, use these steps to edit the instanceconfig.xml file:

1. Change the directory to:
<MW_Home>/instances/instance1/config/OracleBIPresentationServices Component/coreapplication_obips1/

2. Open the instanceconfig.xml file.
3. Search for the <Security> tag.
4. Add the tag  <InIFrameRenderingMode>allow </InIFrameRenderingMode>  in the Security section, as illustrated

here:
<Security>
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   <InIFrameRenderingMode>allow</InIFrameRenderingMode>
   <!--This Configuration setting is managed by Oracle Enterprise Manager
       Fusion Middleware Control-->
   <ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
</Security>

5. Save the file.

Editing the web.xml File  
Use these steps to edit the web.xml file:

1. Open the web.xml file from one these directories:
For OBIEE 11.1.1.7
<MW_Home>\Oracle_BI1\bifoundation\web\appv2\WEB-INF
For OBIEE 11.1.1.5
<MW_Home>\Oracle_BI1\bifoundation\web\app\WEB-INF

2. Add the following code to the web.xml file:
<context-param>
   <param-name>oracle.adf.view.rich.security.FRAME_BUSTING</param-name>
   <param-value>never</param-value>
  </context-param>
The following illustration shows the code inserted after the servlet-mapping tag:

3. Save the file.
4. Restart all OBIEE services.
5. Clear the browser cache.

Configuring an Oracle Analytics Server Connection  
This section is applicable only if your enterprise uses OAS reports.

Understanding Oracle Analytics Server  
Oracle Analytics Server (OAS) users are set up separately from EnterpriseOne users. Within EnterpriseOne, a system
administrator can set up different securities to control a user's access to certain applications or functionality.

Oracle Analytics Server (OAS) has various granularities of security at the folder, report, and data level, which are not
provided by EnterpriseOne. EnterpriseOne only controls how to map a user to the OAS user defined by the soft coding
values.
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When a EnterpriseOne user is viewing OAS content, the system uses the mapped Oracle Analytics Server user account
to set up the connection and authentication with the Oracle Analytics Server. Any security setup for that OAS user is
enforced by the Oracle Analytics Server. For example, the user could navigate from an assigned root folder to another
subfolder or could navigate to a dashboard from an action link on a report. It is the administrator's responsibility to
protect sensitive objects and data on the OAS by using the access control list provided by Oracle Analytics Server. This
protection is highly recommended.

For a complete description of this product, refer to this document:  Oracle Analytics Server .

Understanding the OAS Connection Configuration  
All of the OAS reports are located on the Oracle Analytics Server. In order to connect to the Oracle Analytics Server, one
or more OAS connections must be created for the users. Before you can create OAS connections, you create an OAS
connection template.

An OAS connection defines how the system connects to the Oracle Analytics Server for any given EnterpriseOne user.
An OAS connection includes information about the server, the port of the Oracle Analytics server, the OAS user and
password used to establish the connection, and the root folder (optional). An OAS connection can be added for any valid
EnterpriseOne user, role, or *PUBLIC. They represent three different levels of mapping. An administrator can create one
OAS configuration for *PUBLIC to cover all of the EnterpriseOne users or create multiple OAS connection records to
perform mapping at various levels. If multiple OAS connection records are created, the system uses the following rules:

• The system uses the most specific OAS connection configuration (user>role>public).

• When the user logs in with a role of *All, the system prioritizes all roles of the user based on role sequence.

Adding an OAS Connection  
Use the Web Service Soft Coding Template (P953000) application to create a connection to the OAS server. You can type
P953000 in the Fast Path or use this path to navigate to the Soft Coding applications:

Navigator > EnterpriseOne Menus > EnterpriseOne Life Cycle Tools > System Administration Tools > Soft Coding
Administration

To add an OAS Connection template:

1. Access the P953000 application
2. Click Add.
3. Enter BI CONNECTION in the Template Name field.
4. Enter BI Connection in the Description field.
5. Enter BI_CONNECTION in the SoftCoding Key field.

Note:  The value for SoftCoding Key must be BI_CONNECTION. You cannot use any other value for this field.

6. Enter the following in the Value field:

<webservice>
<endpoint>
http://<server>:<port>/analytics-ws/saw.dll?SoapImpl=</endpoint>
<username>username</username>
<password>_||_BI_PASSWORD_||_</password>
<properties>
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<property><name>root catalog</name><value>root catalog
folder</value></property>
</properties>
</webservice>

7. Enter the Mask Fields in the grid (for example, BI_PASSWORD).
Mask fields are the fields that have _ | | _ as a prefix and postfix. However, you do not include the prefix and
postfix when entering the mask field in the grid. The system adds the prefix and postfix for you.

8. Click OK to save the template.

Softcoding Value Guidelines  
When creating the OAS connection template, use the following guidelines to ensure valid softcoding value parameters.

Http Address  
The http address must follow this format with a valid Oracle Analytics Server name or IP address and port number:

http://<server>:<port>/analytics-ws/saw.dll?SoapImpl=

Username  
The user name must be a valid OAS user name.

_||_BI_PASSWORD_||_  
You have two ways to supply the password for the OAS user:

• Use a placeholder parameter (masked parameter) in the softcoding value and assign the value to the
parameter in the grid. The above example used a placeholder parameter called BI_PASSWORD and defined the
BI_PASSWORD variable in the grid. The _ | | _ prefix and postfix are markers for placeholder variables.
When used this way, the value is encrypted before it is saved into the database and is masked for future display.

• Use plain text directly in the softcoding value.

Root Catalog  
The root catalog provides the default entry point folder when a user launches the OAS catalog to create OAS content. By
default, this folder could be the root folder, which is a forward slash (/) in the template. However, for security reasons,
accessing the OAS catalog at the root level may not be allowed in production. You should use a more specific path
instead.

Note:  Within the <property> tags, the <name> must be root catalog because this is the hard-coded name in the
system. If you use another name, the system ignores it. Only the <value> element is configurable.

There are two ways to define the root catalog:

• Log into the Oracle Analytics Server and click the Catalog tab and then the Manage Catalog button. The
Manage Catalog window appears with the navigation link start from root folder "/". Drill up or down by clicking
the parent or child links. When you find the folder location that you want to use as the root catalog for the
EnterpriseOne end user, manually enter the folder path (for example, /shared/SampleSales) as the softcoding
value for root catalog. The path is case sensitive. Make sure that you type the exact folder path. If the path is
misspelled, EnterpriseOne fails to open the path. If you need to change the value for the root catalog, you must
correct the value in P954000 and restart the HTML server to clean up the cached information.

• The second approach can help you avoid typographical errors. You can use value "/" for initial testing if the
mapped OAS user has permission to access the root folder.
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Creating an OAS Connection  
Use the Soft Coding Records (P954000) application to create a connection to the Oracle Analytics Server. You can type
P954000 in the Fast Path or use this path to navigate to the Soft Coding applications:

Navigator > EnterpriseOne Menus > EnterpriseOne Life Cycle Tools > System Administration Tools > Soft Coding
Administration

To create an OAS connection:

1. Access the P954000 application.
2. Click Add.
3. In the User/Role field, enter the EnterpriseOne user, role, or *PUBLIC.
4. In the Environment Name field, enter the EnterpriseOne environment for which you are creating this OAS

connection.
5. In the Template Name field, enter BI CONNECTION.
6. In the Soft Coding Key field, enter BI_CONNECTION.
7. Click the Populate Soft Coding Value button to populate the Soft Coding Description and Soft Coding Value

fields with the information from the BI CONNECTION template.
8. Change the user name and root catalog in the Soft Coding Value for your connection.
9. Enter the Mask Value for any Mask Fields. For example, enter a value for BI_PASSWORD. You do not need

to use the prefix and postfix values (_ | | _) when entering the mask field in the grid. The system adds these
automatically.

10. Click OK to save the record.

Enabling Oracle Analytics Server Objects  
Any EnterpriseOne user who should have access to OAS content, either to create or view the content, must have access
to the Oracle Analytics Server.

Use these steps to set up user access to the OAS server.

1. Install the latest update of EnterpriseOne Tools.
2. Install the latest version of Oracle Analytics Server and the Oracle Analytics Server adapter for EnterpriseOne.
3. Set up Oracle Analytics Server user groups and security.
4. Set up the EnterpriseOne user and roles.
5. Set up mappings between the EnterpriseOne user and roles to the Oracle Analytics Server user.
6. Inform users about their access to OAS reports (content creators and content users).

Disabling the SSO for Oracle Analytics Server 5.9  
Oracle Analytics Server 5.9 is supported only with Oracle WebLogic Server version 12.2.1.4 and above and is not
supported with WebSphere Application Server.

1. Log in to Oracle Enterprise Manager of Oracle Analytics Server.
2. Navigate to biInstance.
3. Click the Security tab and enable the Edit option.
4. Disable the SSO.
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Disabling iFrame Busting  
The Oracle Analytics Server automatically enables iFrame busting. When a user receives a system message indicating
that OAS content cannot be displayed in an iframe, you can use the following steps to disable iFrame busting:

1. Stop all OAS services.
2. Edit the instanceconfig.xml file.
3. Edit the web.xml file
4. Restart all OAS services.

Note:  Ensure that you are editing the correct locations of the files.

Editing the instanceconfig.xml File  
After you stop all of the OAS services, use these steps to edit the instanceconfig.xml file:

1. Change the directory to:

<MW_Home>/instances/instance1/config/OracleBIPresentationServices Component/coreapplication_obips1/
2. Open the instanceconfig.xml file.
3. Search for the <Security> tag.
4. Add the tag  <InIFrameRenderingMode>allow </InIFrameRenderingMode>  in the Security section, as illustrated

here:

<Security>
   <InIFrameRenderingMode>allow</InIFrameRenderingMode>
   <!--This Configuration setting is managed by Oracle Enterprise Manager
       Fusion Middleware Control-->
   <ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
</Security>

5. Save the file.

Editing the web.xml File  
Use these steps to edit the web.xml file:

1. Open the web.xml file from the following directory:

For OAS 5.9

<MW_Home>\Oracle_BI1\bifoundation\web\appv2\WEB-INF
2. Add the following code to the web.xml file:

<context-param>
   <param-name>oracle.adf.view.rich.security.FRAME_BUSTING</param-name>
   <param-value>never</param-value>
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  </context-param>

The following illustration shows the code inserted after the servlet-mapping tag:

3. Save the file.
4. Restart all OAS services.
5. Clear the browser cache.

Setting up OAS 5.9  

1. Edit repository/Admin/Configuration/xmlp-server-config.xml.
2. Add the following properties to this file:

<property name="FRAME_ANCESTORS" value="'self' host(s)"> 

In the above property, you can enter multiple hosts with the respective port numbers separated by a space (for
example, slc16iua.example.com:9704 *.example.com:7878). Remember to include 'self' in the property.

<property name="X_FRAME_OPTIONS" value="false"/"> 
3. Restart the Oracle Analytics Server.
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8  Creating A CafeOne Layout for the Media
Object Viewer (Tools Release 9.2.8.2)

Understanding the Media Object Viewer  
Media object attachments such as text, URLs, and files, are an important part of enterprise data in addition to the
structured data that comprises EnterpriseOne transactions such as numbers, dates, and strings. You can embed
the Media Object Viewer within a Composite Application Framework layout, which enables you to create, view, and
download the attachments in context, side-by-side with the forms and grid rows to which the media objects are
attached.

Creating a CafeOne Layout for the Media Object Viewer  
Before you create a CafeOne layout for the Media Object Viewer, you must first know the media object data structure
for the media objects that are attached to the form. If you want the Media Object Viewer to show attachment content
dynamically, in other words, to change based on some data on the form or in a grid row, you must also know the key
field(s) for the media object data structure. You can discover both by inspecting an existing media object attachment on
the form.

1. Navigate to the form for which you want to create a Media Object Viewer layout.
2. Locate an existing media object attachment, either on the base form or in the grid. If there isn’t one, you can

create one.
3. Click the Attachment (paper clip) icon to open the Attachment Manager pane.
4. On the Attachment Manager pane, click the About Attachments (i) button.

The window shows you the Attachment Information, including the media object data structure and key(s). For
example, opening the Attachment Manager pane on Sales Order Detail - Customer Service Inquiry (P4210)
shows the media object data structure (GT4211A) and the four key fields:

Record this information, you will need it in a subsequent step.
5. Close the window and return to the form.
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6. From the user ID drop-down on the menu bar, select Edit Form Layout.
7. In the Name field, select Create to create a new layout.
8. Click the Create New Content icon. A window with the types of content you can create appears.
9. Click the Attachments option, an empty frame appears. Drag and drop the empty frame into the workspace.

You can position the empty frame horizontally or vertically on the framework workspace. After you drop the
empty frame in the workspace, the frame is named Create link to Attachment Viewer. The title bar includes
a Save icon and a Close icon. Clicking the Close icon before saving the content cancels the content. The Create
link to Attachment Viewer frame is grouped into three sections:

◦ Link Information.

◦ What type of link.

◦ When do you want to see it.

Entering Attachment Link Information  
The Link Information section identifies the location of attachments for this form. To enter link information:

1. Enter the media object data structure you discovered earlier in the Data Structure field. For example, for Sales
Order Detail - Customer Service Inquiry (P4210) the media object data structure is GT4211A.

2. Enter a Name for the content frame.

This is a required field. The system automatically populates this field. You can change this entry to a more
meaningful name. The name that you enter can be up to 30 characters.

3. Enter a Description for the content frame.

This is an optional field. The system automatically populates this field. You can change this entry to a more
meaningful description, or you can leave this field blank. The description that you enter can be up to 100
characters. If the Description field is blank, the system automatically uses the value that you entered in the
Name field as the description of the content frame.

After you enter the link information, you can click Save icon on the Attachment Viewer title bar to save the link
information and then click the Save icon on the Layout title bar to save the CafeOne layout itself.

To edit the content after saving:

1. Click the Detail(i) icon in the Media Object Viewer title bar.
2. Click the Edit icon in the Media Object Viewer title bar.

You can then proceed to edit the attachment information.

Mapping Attachment Parameters to the EnterpriseOne Form  
The What type of link section determines whether content remains constant or changes when a value in a mapped
field on the EnterpriseOne form changes. The attachment that you entered in the Link Information area is called a
template attachment or a parameterized attachment and is used by JD Edwards EnterpriseOne to generate parameters
that you can map to the EnterpriseOne form-level field values or to a grid-row column.

The type of link is set to Static Link by default. This means that the attachment content is constant and does not
change.
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When you select Dynamic Link, you can map a parameter from the content to a form-level field value or grid-row
column on the enabled attachments. The data structure becomes read-only, and the search and info icons are hidden
until the option is changed back to Static Link. The parameter table format consists of three columns:

• The Parameters column lists the key fields for the media object data structure.

• The Operation column provides a drop-down list from which you select whether to map a parameter to a field
on the current EnterpriseOne form or leave it as is.

• The Parameter Value column shows the data dictionary item and name of the field on the form that you map
to the parameter. You can add multiple fields as well as custom text in the Parameter value column.

To map attachment parameters to EnterpriseOne form-level fields:

1. In the What type of link section, select the Dynamic Link option.
2. Select an attachment parameter and change the Operation column to is mapped to.
3. Map data items on the form to parameters (key fields) by clicking the + icons on the form. Save the entered

information and the CafeOne layout.

For example, to map the four key fields of the GT4211A data structure to fields on the Sales Order Detail -
Customer Service Inquiry (P4210) form, click the + icons on the corresponding grid fields:

Setting Conditions for Displaying Media Object Attachment
Content  
The When do you want to see it section determines whether the specific content you are creating always appears on
the Composite Application Framework when this EnterpriseOne application form is opened or if this content appears
only when specified values are entered on this EnterpriseOne application form. The Always option is set by default. This
means that this content always shows in the Composite Application Framework when this form is opened.

When you select the Sometimes option, you define the values that must be entered in the EnterpriseOne form for this
content to appear on the Composite Application Framework.
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9  Glossary

authorized application form  
A JD Edwards EnterpriseOne application form that is enabled for the composite application framework. Also referred to
as the enabled form.

composite application framework  
A user interface framework that enables JD Edwards EnterpriseOne applications to integrate with multiple third-party
contents and applications.

conditional setting  
A value defined on the enabled form that determines whether or not the associated content frame appears on the
layout. When the defined value is entered on the enabled EnterpriseOne form, the content appears on the layout. When
a value other than the defined value is entered on the enabled Enterprise form, the content does not appear on the
layout.

content  
Information from a web page, an EnterpriseOne form, or an OBIEE report that appears on the composite application
framework for a defined JD Edwards EnterpriseOne form and user.

content frame  
The presentation of multiple content from multiple sources on the composite application framework.

context link  
A JD Edwards EnterpriseOne form header field and value or grid column and value that defines when the system should
display content.
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dynamic link  
A parameter in the content that is mapped to the enabled EnterpriseOne form header field or grid row column.
When the mapped value is changed on the enabled EnterpriseOne form, content that is mapped to the enabled form
automatically updates to show relevant information for the new value.

edit mode  
When used with the composite application framework, a way for the user to create, modify, and delete layouts and
content. The edit mode is accessed from the EnterpriseOne Personalization menu.

embedded EnterpriseOne form  
An EnterpriseOne application form that appears on a layout to provide information that is relevant to the enabled
EnterpriseOne form.

enabled EnterpriseOne form  
The core EnterpriseOne application form on a layout. The application form along with a user (or role), environment, and
application version creates the composite application framework.

layout  
The presentation of the specified JD Edwards application form and associated content on the composite application
framework. An application form may have one or more layouts.

static link  
Content that appears on a layout in the composite application framework and displays the same information regardless
of values entered on the enabled form. This content is not mapped to the enabled EnterpriseOne form.
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UDO  
An abbreviation for User Defined Object. UDOs are web objects EnterpriseOne users create using the EnterpriseOne
web interface

web service softcoding template  
An XML document that provides the structure for a soft coded record.

web page template  
Web page templates are optional and are a way to simplify the task of creating web page content for commonly used
website URLs.
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